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Convert KonturLines to Polygones

Seringkali anda inginkan menampilkan beberapa kelas elevasi dengan warna abu-abu atau warna
lain. Jika anda hanya memiliki data elevasi dalam bentuk garis (garis kontur) anda harus membuat
geodata dalam bentuk polygon dulu karena garis tidak bisa diberikan fill color atau fill lainnya.

Quantum GIS memiliki tool Geoprocessing Lines to Polygons (Vector > Geometry Tools > Lines to
polygones). Tetapi tool ini tidak berfungsi dengan baik untuk geometri yang kompleks (seperti garis
kontur).

Vector | Raster Database CadTools Web Help
Analysis Tools 3 1
Coordinate Capture 4 @ & & D ? L]
Data Management Tools *

Dxf2shp - <

‘/ Check geometry validity

Geoprocessing Tools @ Export/add geometry columns
GPS

Polygonizer

@ Polygon centroids

Research Toals

v
v
v

' Delaunay triangulation
v
, Yoronoi Polygons
v

Road graph

& simplify geometries
Densify geometries

Spatial Query
i

Multipart to singleparts
1: Singleparts to multipart

@ Polygons to lines
Lines to polygons

Extract nodes

alternatif lain adalah mengunakan Plug-In Polygonizer yang bisa diakses dari QGIS Plug-In
Repository.

Install Plug-In Polygonizer

1. Pastikan bahwa computer anda terkoneksi dengan internet.

2. Pada Menu Plugins, pilih Fetch Python Plugins...Pilih Tab Plugins dan type Polygo di dalam
Filteruntuk mencari Plugin “Poygonizer” di QGIS. Plug In Repository (QGIS Repository adalah
kumpulan Plug Ins yang tersedia di Quantum GIS Server)

3. Pilih Polygonizer dan klik install Plugin
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| Blugins | Vector

Raster

[ _' Fetch Python Plugins...

Database CadTools

Web

Help

F! QGIS Python Plugin Installer - 143 plugins available

O. Manage Plugins...
Python Console Plugins | Repositories | Options |
(SR ' Filter: | Palyg all repositories | |any status -
Google Layers L .
GRASS 3 Status Name ersion Description
mmqgis 3 not installed MaxWidth 1.0 Calculates the maximum width of a polygon.
- . not installed Points20ne 0.210 Create lines and polygons from point layers. This plugin was originally created by Pavel Kapust
Openlayers plugin 4 not installed Coloring a map 01 Coloring a map such that two contiguous polygens do not have the same color. The algorithm ¢
QuickMultisttributeEdit * not installed Html Image Map Plugin 0.54 This plugin generates a HTML-image map file+img from the active point or polygon laye
notinstalled Improved Polygon Capturing 1.0 Add linesegments with predefined length while digitizing polygons and lines
not installed Arrows 0.2 Draw polygon arrows based on polylines
not installed Centroids Maker 1.0 Make centroids of polygons
not installed Paoint sampling tool 035 Samples polygon attributes and raster values from multiple layers at specified sampling |
not install " reates a polygon from azimuths and distances,
installed Polygonizer reates polygons from intersecting lines [requires shapely library)
£l | E1D
Upgrade all Il Reinstall plugin ]I Uninstall plugin
Help The plugins will be installed to ~f.qgis/python/plugins Close

4. Plugin itu akan didownload dan diinstall.
5. Anda bisa memeriksa hasil install dengan klik di Menu Plugins=> Manage Plugins... pastikan
bahwa kotak di depan Polygonizer dicentang (Plugin aktif).

Flugins

Vector Raster

Datz

| . Fetch Python Plugins...

. Manage Plugins...
Python Console

Generalizer

| Google Layers
GRASS

mmaqgis
OpenlLayers plugin
QuickMultisttributeEdit *

Filter

To enable [ disable a plugin, dick its checkbox or description

L2

_ OpenStreetMap plugin (Version 0.5)
x Viewer and editor for OpenSiIeeiMap data
x &

Installed in Web menu/toolba
ol

ﬁ. Polygonizer (2.1)

Creates polygons from |nter..ect|r1q lines
Installed in Vector menu/toolba

Oracle Spatial GeoRaster

Access Orade Spatial GeoRaster
Installed in Layers menu/toolbar

Plugin Installer (Version 1.2.1)

Downloads and installs QGIS python pluglns
in Plugins menu!{

Installed i

QuickMultiAttributeEdit (version 1.0)
%uiddﬂulhnttnbuteEdltéJIutghn want to be a very guick and hand\-I way to update a
for

x z
the sel butes to the current/active lay
Installed in Plugins menu,-'ton r

Plugin Directory: C:/PROGRA~2/Quantum GIS Lisboa/apps/qgis/plugins

Select All Clear Al

Cancel

6. Plugin Polygonizer sekarang bisa diakses lewat Menu Vector > Polygonizer

Vector | Raster Database
Analysis Tools b
Coardinate Capture 4

Dxf25hp

Data Management Tools *

Geometry Tools b

Geaprocessing Tools 4

CadTools

Web

He

@ ué

Lo Lo L

About

GPS b

P Qd

Research Tools 4 @
Road graph b
Spatial Query b

XY tools 4
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Mengunakan Polygonizer (Membuat fiturPolygon dari fiturGaris)
1. Polygonizer akan membuat polygon dari masing-masing wilayah yang dilingkari oleh fitur-
fitur garis.

o
P B Wik Vo Ustmerls WcH Doty do Wkt Proessenfader Femoc

b Jiy, i BRD BALARNPPRALA B GE&S-O 50 [y = wag =
R T Dri@rtoashianssn U L8 | b5 (%
oy ax
g

2. Buka QGIS dan add layer 1 _benoa_kontur _.shp dari Folder Kontur2 Polygone
3. Buka Polygonizer dari Menu Vector 2 Polygonizer = Polygonizer
4. Pilih 1_benoa_kontur sebagai Input line vector layer

pilih New Method,

jangan mencentang Output file lalu klik OK

File Edit View Layer Settings Plugins Vector Raster Database CadTools Web Help

Draea &s

e t"> & & & % |_benoa_kontur . (

Caopy table fields from line layer X Create geometry columns

\1-:-} Q’ Q l'f\, Q: Choose polygonization method
s ® New method (faste
o % Lﬁ_ T—r— Old methed (slow, use only when new method doesn't work)

Output file

l Browse

Close

R Control rendering order
Crvarview

5. Akan mucul seperti gambar berikut. Pilih WGS84 / UTM Zone 508 untuk referensi spasial
untuk layer baru. Tetapi tool ini hanya membuat dua polygon.
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,,'IE Coordinate Reference System Selector ‘ ? = | A .o
ar
v ek

Specify CRS for layer |_benoa_kontur_polygons =)
\P 4

& Polygenizer . §1

Polygonization finished in 0.72 seconds,)
2 polygons were crested,

Filter
Recently used dii fi yst

Coordinate Reference System

D74 ﬂ Polygonizer
DGNY5 / UTM zone 435
Popular Visualisation CRS / M|
WGS584 / Pseudo Mercator

ﬁg@‘—l [ |_benoa_kontur | hd l
WG5 84/ UTM 505
T 4 Zone [ Copy table fields from line layer [X] Create geometry columns
Kl I
Coordinate reference systen

® New method (faster)

Coordinate Reference Systern (O 0Old methed (slow, use only when new method doesn't waork)

~WGS 84 / UTM zo1
~WGS84 /UTMzof | [] outout file

WG5S 84 / UTM 20
WGSB4/ UTM zof | | ] | Browse
~WGS84 / UTM z0
: friom s s

.
+proj=utm +zone=50 +south +ellps=WG584 +datum=\WGS84 +units=m +no_defs +towgsd4=0,0,0

Input line vector layer:

Choose polygonization method

[ ] [ 0K ] Cancel

T

6. Halini dikarenakan Plugin Polygonizer perlu wilayah yang dikeliling oleh garis.
Kita harus membuat garis yang akan mengelilingi areal yang akan jadi polygone elevasi dan
kita juga masih perlu garis kontur Elevasi “0” / Garis Pantai.
hapus layer 1_benoa_kontur_polygons ini dari proyek kita.
Add layer a_benoa_Wi lAdminDesa pada proyek.

9. Mulai edit session pada layer I_benoa_kontur dan zoom pada ujung sebuah garis
kontur. Pastikan bahwa snapping pada vertex pada layer 1 _benoa_kontur aktif.

A —

. Project Properties... Ctrl=Shift=P
\ Custom CRS.. I Y |Layer |Mode |To|erance IUnits | Avoid Int. |
Style Manager... || abenoa \WilidminDesa fovertex > 0000000 ppels v
. X | benoa kontur to wertex > |15 pixels - I
“, Configure shortcuts... |
o 1 |
“4 Customization... l
~y Options... ]I Enable topological editing Cancel Apply

Snapping Options...

10. Digitasi garis baru dari ujung masing-masing garis kontur (snapping aktif) sampai keluar
wilayah Administrasi Desa Benoa sperti di gambar berikutnya.
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R

I_benoa_kontur
Q Zoom to Layer Extent

. \:| Show in Overview
‘ Remove
Set Layer CRS
Set Project CRS from Layer

Open Attribute Table

Save As...
Save Selection As...
Query..
\:| Show Feature Count
Properties
Rename
Copy Style
Add New Group
[0 Expand All
[ Collapse All
\:| Update Drawing Order

® Control rendering order

Qwerview

11. Stop Editing (Toggle Editing) dan Save edits.

12. Sekarang kita masih perlu memasukkan garis kontur elevasi “0” / garis pantai dan garis batas
wilayah desa benoa di dalam shapefile 1 _benoa_kontur.

13. Di Menu Vektor pilih Geometry Tools = Polygons to Lines dan pilih
a_benoa_WilAdminDesa. shp sebagai Input polygon vector layer dan
1_benoa_btsAdmDesa.shp sebagai Output shapefile.

Vector | Raster Database (CadTools Web Help

Analysis Tools G

LCoordinate Capture c @ ﬂ ﬁ . P 'E
Data Management Tools ¥ \ \
Dxf25hp v g@ U 5
@ Check geometry validity

J Export/Add geometry columns

Geoprocessing Tools

& |

L3
. ' @ Polygon centroids
i »
iuirgun::r | , @& Delaunay triangulation nput pal v -
esearch Toals ygon vectar
N oronoi Polygons -
Road graph 3 o lyg : |- X | v]
Spatial Query D & Simplify geometries | inDesa
;‘I‘ tools 3 Densify geometries
4 @® Multipart to singleparts Output file

of Singleparts to multipart [Da'&:Latihanﬂ(ontJrZ’dmonetest,ﬂ_benoa_btsAdeesa.shp] [ Browse ]

Polygons to lines

F Lines to polygons [l 0% ] [ QK ] [ Close ]
f Extract nodes 2

14. Add layer garis batas desa Benoa (1_benoa_btsAdmDesa.shp) pada proyek kita.
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15. Untuk gabung garis-garis dari shapefile I _benoa_kontur .shp dan
1_benoa_btsAdmDesa.shp, pilih Menu Vektor > Data Management Tools > Merge
shapefiles to one dan pilih/centang Select by layers in the folder, klik Browse dan pilih dua
shapefile (I_benoa_kontur._.shp dan I_benoa_btsAdmDesa.shp) (dengan tekan
CRTL anda bisa pilih beberapa file). Untuk Output shapefile gunakan nama seperti
tmp_1_benoa_kontur.shp

16. Klik OK
k Select by layers in the folder I
Vector | Raster Database CadTools Web Help Shapefile type [Polygon | ']
Analysis Tools > f Input files
Coordinate Capture * @ a ﬂ D
. Datal atihan Kontur 2Polygonetest/l_benoa_kontur.shp Browse
Data Management Tools t G E T LRI | J T L Lailel)]
Dxf25hp ' '_-' Join attributes by location Output shapefile
Geometry Tools > .
) v Split vector layer atihan,Kantur 2Polygonetest/tmp_|_benca_Kontur.shp Brawse
Geoprocessing Tools b
grge il g 0 0 2
GPS > o ®| Add result to map canvas
Create spatial index
Polygonizer 4 “ 0% ]
Research Tools b “ ]
0%
Road graph >
XY tools b |

17. Akan menambah layer baru dengan garis kontur dan batas desa ke proyek kita.
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Layers &)1
'l:ﬁ\ I_benca_kontur
" 1_benoa_btsAdmDesa
- | '1\-7:\ tmp_|_benoa_Kontur
& =_benoa_wiladminDesa

i - =

18. Jika anda mencoba Polygonizer lagi pada layer tmp_1_benoa_kontur anda akan lihat
bahwa hasil sudah lebih bagus. Tetapi ada beberapa wilayah tinggi yang tidak jadi polygon.
hal ini di karenakan garis tersebut tidak ditutup dengan sempurna. Anda harus memasikan
semua garis ditutup. Untuk menemukan gap di dalam garis anda bisa membuat symbology
pada layer 1 _benoa_kontur di mana ada symbol di vertex pertama dan akhir garis.

19. Padalayer 1_benoa_kontur pilih Properties dan tab Style

20. Pilih Single Symbol dan klik tombol Change...

@ Style 7 Labelz _ Fields \ General @ Metadata :@J‘ Actions "ﬁ Joins [¥ Diagrams ¥ Daﬂ

| & Single Symbal | Old symbalogy

Unit Millimeter -
width 1,00000 =
Transparency 0% C
Color B change
4, Change... Advanced ~ I:lil'; Save as style
Saved styles Style manager...
—— ISEEREE e ——————  —

21. Klik Add Symbol Layer

22. Pada Symbol Layer baru sebagai Symbol layer type pilih Marker Line
23. Pilih On last vertex only dan pilih marker symbol yang mudah dilihat.
24. Klik ok
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Marker line
Line decoration

Symbal layers symbol layer type

€ Marker line I SR TR UE
Simple line
Marker ]

m— Simple line

Marker placement

() with interval [ 3,00

| onevery vertex

I ® on last vertex only I

= [ on first vertex only
® || = ] [:] & _
' on central point
Symbol preview
X Rotate marker
Line offset 0,00000
———

[ ) oo

25. Sekarang anda bisa lihat di mana masing-masing garis memiliki vertex akhir dan ketika anda
zoom in pada vertex akhir itu, anda bisa memeriksa bahwa garis memang ditutupi. Di mana
masih ada gap anda bisa membuat garis baru untuk sambung vertex akhir dengan vertex

pertama.

26. Ketika anda selesai membuat garis untuk menutup garis kontur ulangi aplikasi tool
Polygonizer pada layer tmp_1_benoa_kontur.shp.

[ Input line vector layer: ‘&\ I_benoa_kontur
tmp_|_benoa_Kontur v | B ‘]Qf\ I_benoa_btsAdmDesa
Copy table fields from line layer | Create geometry columns . tmp_I_benoa_Kontur_pol...

Choose polygonization method

@ New method (faster) tmp_l_benoa_Kontur
& EHrE I e o e ) @ | @ a_benoa WilAdminDesa

Output fie

[ ] [[oome

1] 0% ] ok Close

27. Jika anda merasa puas dengan hasilnya save layer tmp_|_benoa_polygons sebagai
a_benoa_kontur.shp
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| ,

Format | ESRI Shapefile -
Seveas an/KonturZPolygonetest/a_benoa_Konturshp
Encoding | UTF-8 -
Layer CRS -
B CRS
Layers WGES 84 / UTM zone 505 Browse

L[:‘\ I_benoa_kontur OGR creation options
@[ | \_ 1 benoa_btsAdmDesa

2 Ll R SR Rl . Zoom to Layer Extent

Data source
Show in Overview
tmp_I_benoa_Kontur

p_L - ﬂ Bemaove

. a_benoa WilAdminDesa

Set Layer CRS
Set Project CRS from Layer

Layer

[==] Open Attribute Table
.

oy e
Skip attribute creation

= Add saved file to map
Save Selection As...

Show Feature Count oK Cancel Help

Pranartiac

28. Remove layer tmp_1_benoa_kontur dari proyek dan add layer
a_benoa_kontur.shp.

29. Menambah attribut Elevasi pada attribut table pada layer a_benoa_kontur (Decimal,
Width: 5, presicion: 1)

25 o
J Attribute table - a_benca_Kontur = 0/ 22 b = | = | 22

| ] area " perimeter R Elevasi

0 8938267.7 3146585 Comment

1 — ol i Type Decimal number (real) -

2 139956406 3nzia7

3 3629985.2 57589.48

4 481202915 477439 e

5 179148011 22093.28

6 728033.39 19032.89 Width 5 = @

= QEARGAD 11 e L e e Predision lll | £

@EEE AR o] | conce -
Show selected only Search selected only Close

30. Isi Elevasi dengan elevasi (anda bisa membuat label pada layer 1 _benoa_kontur
menampilkan field Elevesi).
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<Jp o Zmmerams L, e

R Label this layer with | ELEVESI |+ E]

- U Lorem Ipsum

Sample

' Label settings "\ Advanced Data defined settings
I |

Text style

Font MS Shell Dig 2, 8.25 pt E] Color B Size | &,2500 : In points |+

® Buffer

Size | 1,00 mm : Color D

\ e ey

31. Toggle Editing pada layer a_benoa_kontur dan pilih fitur-fitur dengan identify tool

N

& Quantum GIS 1.8.0-Lisboa

File Edit View Layer 3Settings Plugins Vector Raster Database CadTools Web Help

TEmEdds ERKPEPLS 7 tcerity e

Pl@- i Ba-@RK T e/ Jae

ArVONBRIADDC | mmr—

THPAARRNARLS £ O o e
Layers

perimeter 314

Copy attribute value

% L“_‘\ I_benoa_kontur Copy feature attributes

Clear results
Clear highlights
Highlight all
Highlight layer
Expand all
Collapse all

L‘.‘\ |_benoa_btsAdmDesa

é a_benoa_Kontur

. a_benoa_WilAdminDesa

32. Di Identify Results window klik kanan dan pilih Edit feature form dan isi Elevasi (Elevasi
tertinggi di kelas ini).

1 s s (L i

area | 89382677

perimeter | 31465.55

I Elevasi 12.5

0K Cancel

QGIS Followup —Jan 2013 — Denpasar - GIZ DeCGG & GIZ IS Protects

10



33. Informasi Elevasi dari Label 1 _benoa_kontur sangat berguna saat ini. Untuk mengetahui
dengan mudah fitur mana yang sudah diisi dengan attribut ketinggian,silahkan membuat
pada layer a_benoa_kontur symbology “Categorized” mengunakan attribut Elevasi dan
memberi warna beda pada fitur yang belum punya nilai Elevasi. (pada gambar berikut
ditunjukkan dengan warna hijau)

Layers
E‘ x Li’.’\ I_benoa_kontur el

7 —
4 Identify Results (2] =

|Feature 4 |\|'a|ue |
=0 a_benoa_Kontur
[=h area 179148011

[ [Actions)

[F [Derived)

- Elevasi

o area 1791480.11

‘- perimeter 22093.28

E‘ = Lﬁ‘ |_benoa_btsAdmDesa

a_benoa_Kontur

Close Help

& Control rendering order

34. Save edits.

35. Ulangi membuat Categorized symbology untuk menyesuaikan dengan semua nilai yang telah
dimasukkan. Sekarang anda mempunyai shapefile polygon dengan kelas-kelas wilayah
ketinggian.

8 [

E- 3¢ . a_benoa_Kontur

1125
1325
137.5
150
= a_benoa_WilAdminDesa

X/ Control rendering order

Overview

Catatan: Plugln Poligonizer hanya berfungsi / akan membuat polygon apabila garis -
bertemu/bersilangan antara satu dengan yang lain atau dimana garis snap pada vertex. Hal ini tidak
berfungsi kalau garis snap to segment/edge saja.
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Materi Tambahan - Plugln Generalizer
1. Jika garis kontur anda agak bertangga / stepped anda bisa menghaluskan garis kontur
dengan Plugin Generalizer.
2. Plugin Generalizer bisa diinstall lewat Menu Plugins. Generalizer berfungsi menghaluskan

fitur.

1 Qats Pyinon Pugin nstaller - 16 pugins mvaiebie [ I e Plugins | Vector Raster Database CadTools )
Plugns | Repositories | Options | B Fetch Python Plugins... h @ @
Filter: | gen &l repositories v |anystatus | v {:} Manage Plugins,,, ‘
Status Name: Version Description | Author

- : Python Console ] -
Contour L

EasyPrint L4 Yy

Generalizer Generalizer

GRASS L4
q ] K10 .
mmaqgis 4
Openlayers plugin b
Help The plugins will be installed to ~f.qgis/python plugins Close

QuickMultiAttributeEdit *

3. Plugins - Generalizer - Generalizer dan pilih layer I_benoa_kontur . shp sebagai
Input Line Layer.

4. Untuk Smoothing Algorithm pilih Boyle’s Forware-Looking Algorithm dan pilih 7 (vertex) di
Look Ahead. (anda bisa coba algorithm lain juga untuk dapat yang paling cocok)

Batch mode ?

Input line layer:
|_benoa_kontur -
Options

Alghoritm: | Boyle's Forward-Looking Algorithm -

Lock ahead: 7

4b

Save output layer

l Browse

oK Close
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5. Anda bisa simpan hasil langsung sebagai shapefile dengan centang Save output layer atau
and bisa membuat layer temporer yang bisa anda simpan (Layer = Save as ... ) kemudian
jika hasil tool ini memuaskan.

6. Aplikasi Smoothing dengan Generalizer sebaiknya dibuat sebelum merge shapefile garis
kontur dengan shapefil garis batas administrasi agar tidak merubah batas Administrasi.
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Plugins yang berguna

Open Layers Plugin - Using Bing Maps or Google Maps as Background layer

Dengan Plug-In “Open Layers” anda dapat menampilkan google maps atau bing maps (antara lain)
sebagai background layer di dalam QGIS. Citra akan menampilkan sebagian background layer (WMS-
Layer) di proyekanda. Anda perlu internet yang cepat dan stabil saat mengunakan plugin ini.

1. Install plugin OpenLayers Plugin
. Add shapefiledan data lainnya pada proyek.
3. Klik Plugins - Open Layers plugin dan Pilih Layer yang anda inginkansebagai background
layer.

a. Google Physical Layer: Citra dari Google Maps
b. Google Streets Layer: Jalan dan Points of Interest dari Google Maps
c. Google Hybrid Layer: Citra & Jalan dan Points of interest dari Google Maps
d. Bing Aerial Layer: Citra dari Bing Maps
e. Bing Aerial with labels layer: Citra & Jalan dan Points of interest dari Bing Maps

Plugins | Vector Raster Database Cadlools Web Help
¥ Fetch Python Plugins... ~p @ i m
i} Manage Plugins... E '

Python Console =

Google Layers
GRASS

mmagis

BEEI

| Openlayers plugin Openlayers Overview

-‘l Add Google Physical layer

=) B #] Add Google Streets layer

@ Add Google Hybrid layer

*q Add Google Satellite layer

b ?3 Add OpenStreetMap layer

‘b‘ ;P Add OpenCycleMap layer
£ ;P Add OCM Landscape layer

ﬁ] Add OCM Public Transport layer

L &@! Add Yahoo Street layer

! Add Yahoo Hybrid layer

! Add Yahoo Satellite layer

Add Road layer

Add Bing Aerial layer
Add Bing Aerial with labels layer
G Add Apple iPhoto map layer

File Edit View Llayer Settings |Pugins| Vector Raster Database CadTools Web Help
N W Fetch Python Plugins.. @ ﬂ B 7 3 ) o
SR oy ; < hHh 0 5 T
] B @B &k —lry Manage Plugins.. » e é’ ﬁ E $s " N 4l HE R
00 - Oy~ ey | DnonConsok = O %P PR
' ; g Contour 3 - g -
3 EasyPrint 3 ) ;f e oR o, T « <+
-~ H0DE ! C «FCH QPRAQALK G)
Generalizer '
Leyers F3  grass ’
% £ I_benoa bisAdmDesam...|  mmagis 3 A
— Opentayers plug OpenLayers Overview b
= lur i QuickMultiattributeEdit * | M Add Google Physical layer i
o
B %\ Jalan | i
X & Google Hybrid Y 50GIe atelie Tayer .
- RIS /4 Add OpenStreetiap layer
B\ 1_benoa btsAdmDesa 8 Add OpenCycleMap layer
— /= Add OCM Landscape layer
& a benoa kontur 8 Add OCM Public Transport layer
B | @ a benos WilAdminDesa | @! Add Yahoo Street layer
| @' Add Yahoo Hybrid layer
‘ ©! Add ¥ahoo Satellite layer
| | Add Road layer i
| . e
=5 Add Bing Aerial layer "
=] Add Bing Aerial with labels layer 4
["1 Add Apple iPhoto map layer
|
|
|
%| Contral rendering arder | &
! /
@ | | = 2
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Trace Digitize Plugin

Dengan Plugin ini anda bisa trace / digitasi fitur berdasar vertex fitur di layer lainnya.
Plugin masihpunya status experimental. Untuk install ini anda bisa dengan

1. Plugins = Fetch Python Plugins = Tab Options
2. Pilih Show all plugins, even those marked as experimental.

m Vector Raster Database (CadTools Web Help
| "% Feten Python Plugins... — e . . - .
C)I Manage Plugins... ,P! QGIS Python Plugin Installer - 189 plugins available { 7 8 J
Python Console
Plugins Repositories Options
Contour v
EasyPrint 3 Chedk for updates on startup
Generalizer Y once a day |,]
GRASS 4 . L o . . . :
R Note: If this function is enabled, Quantum GIS will inform you whenever a new plugin or plugin update is available.
mmagis Otherwise, fetching repositories will be performed during opening of the Plugin Installer window.
Openlayers plugin D
ickMultiAttributeEdit
DuickMultiAttributel |. Alawed phigns

Only show plugins from the official repository

I ® Show all plugins, even those marked as experimental I

Note: Experimental plugins are generally unsuitable for production use. These plugins are in early stages of
dewvelopment, and should be considered ‘'incomplete’ or 'proof of concept’ tools. QGIS does not recommend installing
these plugins unless you intend to use them for testing purposes.

Help The plugins will be installed to ~/.qgisfpython/plugins Close

3. Ditab Plugins cari “trace” di Filter Field dan install traceDigitize plugin.

Flugins Repositories Options |

Filter: | trace all repasitories ¥ | any status -

Q ed flowlrace U [ ama y a
installed Contour plugin 091 Trace contour lines and filled contours from irregular or regular points

1 | «|»

Upgrade all [ Install plugin ] [ Uninstall plugin l

Help The plugins will be installed to ~/f.qgis/pythonplugins Cloze

4. DiSnapping options aktifkan snapping pada vertex di layer yang anda ingin gunakan untuk
referensi/dasar/acuan digitasi.
5. Toggle editing pada layer di mana anda ingin mendigit fitur baru dan mengunakan Trace Edit

Tool. %
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6. Tekan CRTL dan geser mouse di atas fitur layer referensi. Anda akan membuat vertex secara
otomatis ketika anda melintas di vertex dari fitur layer acuan.

7. Contoh:

8. Buka MapProyek TraceDigit PET_Benoa. Di Proyek ini kita mau digitize Jalur Evakuasi. Jalur
Evakuasi biasanya mengunakan Jalan, jadi kita mau mendigitasi Jalur Evakuasi berdasar
fitur2 di shapefile Jalan.

9. Set Snapping pada layer Jalan dan pada layer |_benoa_jalurEvakuasi

Settings | Plugins Vector Raster Databas = = = |@ 52 |
/' Project Properties..,  Ctrl=Shift=P i Snappingoptom —

4 Custom CRS...
\ Shye M \:ILayer |Mode |To|erance IUnits | Avoid Int. |
e Manager...
’ N administrasi desa to vertex * (,000000  pi *
Configure shortcuts... % 1ol n : -
alan vertex - pi: | =
Customization...
oot D | Tsunami_10m to vertex > 0,000000  pi| ¥
ions..
P ®X | benoa_jalurEvakuasi | to vertex v 10 pi v

Snapping Options...

Enable topological editing Cancel Apply

10. Start Editing pada layer |_Benoa_jalurEvakuasi dan pilih TraceDigit tool
11. Tekan CRTL dan klik di atas jalan di mana mulai jalur evakuasi
12. Kemudian tahan tekan CRTL dan geser mouse pelan2 sepanjang jalan. Anda akan lihat
bahwa trace Digit tool membuat vertex secara otomatis di mana ada vertex di layer jalan.
13. Ketika anda lepas CRTL digit tool tidak ikut/snap lagi pada layer jalan. Untuk selesai digitasi
klik kanan seperti biasa dengan digitasi.
14. Stop edit session (toggle editing) dan save edits.
Layers

El- %/ 1I_benoa_jalurEvakuasi

=5 3 &‘\ Jalan

» G Tsunami_10m
=8 G administrasi desa

15. Dengan cara ini anda bisa mendigit fitur berdasar fitur di layer lain.

CadTools
Koleksi tools untuk digitasi (misalnya jika anda ingin membuat kotak dengan sudut 90 dengan
sempurna dll.

Mmgqgis
Banyak tools yang mempermudah geoprocessing dll.
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Styles and symbology

Import Styleset
Di Quantum GIS anda bisa membuat dan simpan styles (simbologi presets untuk markers, garis, fills
dan color ramps, dll.) yang anda mengunakan untuk symbology fitur2 di peta anda.

Anda bisa lihat dan kelolah styles dengan Menu Settings = Style Manager

Lo e
o

&9 color ramp

Settings | Plugins ‘Vector Raster Data
Ctrl=Shift+P

_* Project Properties...

%, Custom CRS...

Style Manager...

“4, Configure shorteuts.., [

- I P d

+ + 4+ . : H H :
Gernasdiaand ERTT TP A

Cemetery-example Deforestation-100k Deforestation-25k  Eifin_Wood-100k Elfin_Wao,

PR

“4 Customization...

“4 Options...

Export... Import...

| Close

_’ Edit (=] Remove

Snapping Options...

Help

Banyak styles dibuat oleh SVG-Graphics. Style hanya mengelink pada svg grafik itu. Supaya QGIS bisa
menemuka SVG-grafics anda harus memastikan bahwa lokasi folder SVG grafics terdaftar di Settings
- Options ... > Tab Rendering SVG paths (mungkin anda harus scroll ke bawah)

Sowe
" Fd .
*, General ‘“\ GDAL {}- Flugins ]._q_ Map tools L.l Overlays ].L @
RGB band selection Redband |1 < | Greenband |2 S Blueband |3 =
Use standard deviation [ 2,00 I%]
Settings | Plugins Vector Raster Data Contrast enhancement Mo Stretch -
7 Project Properties... Ctrl+Shift =P
Custom CRS... SEmliE
Style Manager... Path(s) to search for Scalable Vector Graphic (SVG) symbals Add Remove ]
ECOtiguieshotots C:\DVD_Pelatihan_QGIS_Pratect\Grafik\MarkerSymbols
Customization... CA\DVD_Pelatihan_QGIS_Protect\Grafik\My5VGMarkersymbols
F\ServerPatrickPISP\Projects\20130130_QGISforPET\Datalatihan' Symbology\QGISStyles\svg
Snapping Options...
4

Selain membuat style sendiri anda juga bisa menambah style yang sudah dibuat oleh orang lain. Satu
koleksi style adalah symbology-ng-style-eng.xml (http://gis-
lab.info/forum/download/file.php?id=3230)

Sebuah style-file adalah definisi style dalam bentuk XML dan link pada simbol SVG (kalau dipakai)
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<gymbol cutputUnic="MM" alpha="1" type="line" name="Ancient historic walls-25-100k">
<layer pazz="0" class="MarkerLine" locked="0">
<prop k="interval" v="1.2"/>
<prop k="offset" w="0"/>
<prop k="placement" v="interval"/>
<prop k="rotate" w="1"/>
</ layer>
</ symbol>
|<5ymbol o:tp:tU:it=“ﬂg“ alpha="1" type="fill" name="Bamboo-100k"> |
<layer pass="0" class="SimpleFill" locked="0">
<prop k="color" v="191,213,129,255"/>
<prop k="ecolor_ border" w="0,0,0,255"/>
<prop k="offset" w="0,0"/>
<prop k="style" v="densed"/>

<prop k="style border" v="no"/>
<prop k="width border" v="0.26"/>
</layer>
<layer pass="0" class="MarkerLine" locked="0">
<prop k="interval" v="1"/>
<prop k="offset" w="0"/>
<prop k="placement" v="interval"/>
<prop k="rotate" w="1"/>
</layer>
<layer pass="0" class="SVGFill" locked="0">
<prop k="angle" v="0"/>

I<prap k="svgFile" v="/wegetation grounds/bhamboo 1DUk.svg“f>|
<prop k="width" wv="10"/>

</ layer>

</ symbol>

<symbol cutputUnit="MM" alpha="1" type="fill" name="Bamboo-25k">
claver nass="N" ~las=="SimnlaPill" Tnrked="nn-s

Cara install dan mengunakannya seperti berikut:

1. Menambah SVG Folder path dengan Menu Settings > Options - Tab Rendinging SVG Path
klik Add dan pilih folder SVG (yg berada di dalam folder latihan Symbolgy\QGISStyles\
)

2. Buka Settings = Style Manager

3. Klik Import dan browse pada Symbology\QGI1SStyles\symbology-ng-style-
eng.xml

4. Kemudian anda bisa pilih style apa anda mau import (klik dgn CRTL pada symbolnya atau
pilih Select All untuk pilih semua). Andai di sini symbolnya kelihatan aneh memerkisa bahwa
SVG Paths yang anda tadi menentukan adalah benar.

5. Klik Import.

2 s oo SN L sy T o

Select symbols to import f Marker éune &Fil\ &9 Color ramp |
- e 4 [«]
o of i : e T . -
) : | ] E g i H
P 1 11 D i & | ¥ H i it
Cthe Lamdsli e E ] Eo ] Ll -
Forest_o.n_tnft!._a‘ndsllde-ZSK Fruit 5k Bamboo 100k Bamb e
e [IRER o+ N : : H
§ o5 o + ot 5 : Lo~
| | 1 + + + it H H : : H
Fruit Vinery Gardens-25k § Fuit_Gardens-with Vine-100k Cemetery-example Defores!

e i
—_— —

= 3 i~ 5
; |

Eifin Wood [brushwood)-100k Elfin Wood [brushwood]-25k  Forest  Forest-100k Forest-25k @

o Add A Edit (=] Remave Export... Import...
Impart Select all Clear selection Close Close Help

Gas_main-100k Gas_main-25-50k Ground_Oil-pipeline-100k

6. Style telah diimport dan siap untuk digunakan di Layer Properties = Style
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wistle | ek [T Fieds | K Generdl | D vetacata | ot actions | o4} Joins | ¥ piagrams IIZUEB

& single Symbol | old symbology
Unit Millmeter -
Transparency 0% (6 e
Color Change
4, Change... Advanced  * | @ Saveasstyle
Saved styles Style manager...

ala

i 2
Bamboo-25k
Restore Defauit Style Save As Default Load Style ... Save Style ...

Jika style mengunakan SVG Grafik dan anda pindah SVG Folder anda harus menentukan SVG Folder

Path dan restart QGIS.

§ veer | Zine | Lm | 9 coorramp |

0[]

Cemetery-example Deforestation-100k
——————

timber-100k Burnt/Dead_timber-25k Cemetery-25-50k

eforestation-25k  Elfin_Wood-100k Elfin_Wood-25k

Effin Wood (brushwood]-100k Elfin Wood (brushwood]-25k  Forest  Forest100k Forest25k E

A Edit (=] Remove Export... Import...

Close Help

| Marker

| S

IRl | 6 colorramp |

wood)-100k _Elfin Wo

) Edit (=) Remave

Membuat line Fill Pattern

Untuk membuat fill pattern untuk polygone QGIS Simple Fill Pattern tidak akan berskala jika anda

mengeprint/export peta. Sebab itu SimpleFill Pattern tidak bisa mengunakan untuk membuat Fill

Pattern yang bagus.

7 spones M e e

Symbol layers Symbol layer type I simple fil v I Simple fil -
. § . Centroid fill
0 simplefin Symbol layer properties Line pattern Al
Point pattern fill
Colar G fil
Simple fill
Fill style E Outline: Line decoration
& Outline: Marker line
Qutline: Simple line
Border color
Border style Solid Line -
Border width 0,26000 =
& E] = E] Offset X,¥ 0,00000 3 000000 |3
)
Symboal preview
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Anda bisa membuat Pattern dengan mengunakan Line pattern fill dan beberapa symbol layers.

Di bawah anda bisa lihat beberap contoh:

Line pattern Fill
Line pattern fill

[] Line pattern fill

] Line pattern fill

] Line pattern fill
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